
 

Creating ordinary Presentation document

Dr Emile  C. B. COMLAN

Novoasoft Representative in  Africa

Emails: 

ecomlan@scienceoffice.com

ecomlan@yahoo.com

Web site: www.scienceoffice.com



 1

I - INTRODUCTION

It is very usual to make use of software for presentations during symposium,  conference, 
project presentation, thesis defence or lecture. This type of software that uses slides often requires 
a big screen where projection can take place with of course some animations to make a transition 
between the various parts of a subject being presented: such a usage facilitates an understanding, 
legibility and notes taking for the listeners.

Until recently,  the real problem confronting all users of presentation software was the 
amount of time they were compelled to devote to the making of slides. For the animation of a slide 
containing an ordinary text only required the creation of several  text boxes, which means a lot of 
time.

The issue became more complex when it comes to designing slides containing:

a scientific text with mathematical formulae, chemical formulae or macromolecules

objects such as geometrical drawing, function, electronic and mechanical graphs.

PagePlayer is a new generation of presentation software which simplifies on the one part:

Concept,  presentation and animation of slides of various types made up of ordinary texts, 
mathematical formulae,  chemical bonds including macromolecules,  two dimension and three 
dimension graphical representation, geometrical drawings, usual arithmetic operations of primary 
and secondary standards, experimental tools in physics and chemistry etc... 

And on the other part:
concept and animation of geometrical and dynamic constructions including all plane 
transformations ( translation, rotation, symmetry, similarity ) .

As we can note,  PagePlayer has achieved not only once and for all,  problems linked with 
conception and animation of any presentation but also it constitutes an educational tool of 
inestimable value for scientific people at all levels including students.  

There is however a need to mention some functions that make PagePlayer to be not only a 
revolutionary software but also unique in its kind! 

Writing of mathematical formulae takes place exactly as in ordinary text with an automatic 
passage to a new line.

Chemical bonds are carried out with the same way we do when drawing with a pen

The flexibility of the two dimensional and three dimensional coordinates systems simplifies 
graphical representation under all shapes wanted.

Geometrical construction is carried out with an amazing simplicity due to the fact that 
necessary tools for conception are automatically available as soon as the corresponding 
elements of the plan are selected.



1 This technique is explained in the foreword of  ScienceWord user's handbook
 2

A library for drawings is available to store drawings and images for a further use.

The possibility of animating in an independent manner the selection of any part of the text 
( including mathematical or chemical formulae )  not only simplifies the animation of the text 
under all shapes wanted, but also make it very flexible animation sequences.

The possibility of writing or drawing in full screen mode facilitates corrections during 
presentation.

The ability to explore with PagePlayer solutions to scientific questions widens considerably 
the field of application of this educational tool.

Finally,  we wish to draw the attention of the reader to the fact that the many functions 
mentioned above are made possible today thanks to a new theory on which the concept of 
PagePlayer is based: the non linear technique1 designed by Novoasoft.

The linear or non linear nature of the document stands out from others through the structure 
of the basic elements of the said document.  When there is a systematic structure between basic 
elements of a document, the latter is said to be of linear type. Moreover, in a document of linear 
type, there are only basic elements; there is no complex element. All traditional documents are of 
linear type. In contrast, non linear type documents are not only made up of basic elements but also 
complex elements.

Scientific and technical documents are complex documents made up of great number of 
formulae,  curves,  logical graphs,  etc. . .  These are true non linear type documents.  Non linear 
technique makes processing of scientific and technical documents easy.
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II - Familiarisation with PagePlayer software interface 

When PagePlayer is installed,  the  icon appears in the desktop.  By double clicking on the 

icon, the PagePlayer interface appears by default as shown by the image below:

Menu Toolbar
Standard Toolbar

Format Toolbar

Macromolecule

Geometry 

Animation

Math expressions toolbar Math symbols toolbar

The software interface is therefore a frame made up of a work page called slide ( the white space )  
and a set of buttons underlying some programmes for execution of specific assignments;  these 
buttons are categorized in distinct groups called toolbars. The two ends of the toolbars are either 

vertical image buttons  and   or horizontal image buttons  and  .

- Through the first  vertical end or  horizontal end,  it is possible to capture the 
toolbars. You can then drag this toolbar to a new location of the interface reserved to toolbars or 
drop it on your work page for practical needs during processing of a document.

- Through the second  vertical or  horizontal end you access several variable options 
( customising of tools display … )  

- Due to practical reasons linked to reduced size of the screen of some computers,  it is 
recommended to customize the display of a reduced number of really necessary tools.

- To do this, click on  or  button then in the sub menu that opens, click on “Add or 
Suppress”  thereafter in the list of tools that appears tick only elements,  which display is 
necessary for your works
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II - Essential elements to create a PagePlayer document

1 )  Insertion of a slide

To insert a new slide, click on “New Slide” in the “Insert menu” or click on miniature image 
of a work page in the slide navigator then press “Enter”  key.  A PagePlayer document is 
therefore made of several slides.

To create a new PagePlayer document, click on  button in the “Standard 
Toolbar” or use “Ctrl + N” shortcut.

2 )  Designing of slides

This simply is a choice of a background of slides for an attractive presentation.

The choice can be made directly from among existing models.  In this case, 
click on “Slides Design” in the “Slide” menu. The Task Pane ( at your 
right )  displays models as shown next. To select a model, click on it.

Background can be customized.  To do so,  right click the mouse when the 
pointer is on the work page; then in the contextual menu that appears click on 
“Background” .The dialog box that opens below offers several options of 
modification of the background.

3 )  Slides Layout

Slides are made of texts, drawings, images, library objects, tables,

The editing of a slide consists in usage of pre-conceived models with specific 

zones to accommodate text or to 

accomodate table, pictures or objects of Graphics library . To access 

these models, click on “Slide”  menu on “Slide Layout” .  Models appear in 
the Task pane as next. To use a model, click on it.

You may wish to suppress the displayed model on the page work when carrying 
out a drawing for example or for other practical reasons.  In this case,  select one ( or specific 
zones )  to be suppressed and press the suppression button on the keyboard.

4 )  Animation of elements of a slide

Animation plays not only an attractive role in the presentation but also creates a pleasant and 
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dynamic environment. We can distinguish two types of animation: animation by effects applicable 
to objects and texts,  and transition applicable to a slide and geometrical animation using 
animation buttons.

a. )  Animation by effects

To realize such animation, click on “Custom Animation” in the “Slide” menu. Then the task 
pane appears as shown next.

In PagePlayer, you can apply independently the animation effects to a text zone 
or any selection of a part of text of this text zone ( including mathematical 
formulae )  and to any object ( image,  drawing,  table,  experience tool, 
macromolecule … )

To carry out such an animation, select the object to be animated,  then click on 
“Add effect”  from the list of effects that appears,  select an effect.  The 
animation is immediately effected and the name and order of the effect appear 
automatically in the task pane ( see image ) . 

To add other effects ( sound,  colour etc. )  to the animation,  right click on the 
effect name then in the contextual menu that appears,  click on “Effects 
Options”. You can now customize effect in the dialog that appears.

b. )  Transition

To carry out a transition on a slide,  click on “Transition”  in the “Slide”
 menu. Then the task pane appears as on the right.

You can as is the case of animation by effects, add sound effects colors, etc… You 
can also program the activation of the sequences of scrolling of pages in Slide 
Show mode.

5 )  Work pages 

We can note three, work pages from which the slides are designed: normal, note 
page and Teaching. 

The "normal" display page is the one that appears by default during opening of 
a new document.

To access the "note page" ( fig.  next ) ,  click on “Notes page”  in the 
“View” menu. Select the Large text zone then size of front, then write. The 
note is made in the big text zone.  To come back to the normal display page, 
click on “Normal” in “View” menu.

 In PagePlayer you can work in full screen designated as "Teaching" display 
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page. To get the full screen, press F11; to exit full screen press again on F11 or Esc key. 

6 )  Scrolling of slides

Slides can be scrolled in two ways:

By pressing on “Next page” on the keyboard for ordinary scrolling of pages

By slides show through clicking or automatically.

To display the slide show from the first slide, click on  button in the standard toolbar or press 
F5 key.

To display slide show from current slide,  select “Custom animation”  in the “Slide show”

 menu, then in the window that appears click on   button.

7 )  Inserting  Multimedia and Macromedia
You can insert multimedia ( sound or video files )  and macromedia ( flash fils )  from Insert menu 
and get them played in Show. 
When multimedia and macromedia are inserted into PagePlayer file,  they are definitely part of 
that PagePlayer file.  These multimedia and macromedia will be played directely in that 
PagePlayer file on any computer where PagePlayer is installed even if any media player has not 
been.installed on that computer.

8 )  Custom shows

It is possible to view through slide show any part of the entire slides by proceeding as follow.

Click on “Custom shows” in “Slide” menu to get the following dialog box. 

Click on “New” in the dialog box to get the following dialog box
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Through the aid of "Add" button, customize the slide show then click on “Ok” to validate.

To customize other slide shows, follow the same process. Save thereafter your document.
Therefore,  each time you access your document,  you can unroll customized slide show by 
proceeding as follow: 
Click on “Set up show" in the “Slide” menu. The following dialog box appears. 

Tick “Custom show”  case,  display thereafter through the scroll button the customized slide 
shows, and then select a slide show as shown in the image below.

Validate your choice.

F5 key allows scrolling of the whole customized slide show as selected,  while the   
button allows to customize only the slide show from the current slide.

9 )  Add button action to a slide
To add a button action to a slide which effect can be seen only in "Slide Show", click in "Slide" 
menu on action "button"; then select an action from the list of action buttons as shown below
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10 )  Working in Teaching mode F11 
You can edit in full screen or teaching mode with the possibility of displaying the needed toolbars 
or  using a white board tools ( also available in Show F5 ) . To get to teching, just press key F11; 
to cancel it press Esc key. 

 

1 2 3 4 5 6 7 8 9

10 11 12 13 14 15 16 17 18

1-Switch to desktop;  2-Insert blank page;  3-Edit;  4- Drag;  5- Screen pencil;  6-Eraser;  7-Tool; 
8-Change the background;  9- Exit;  10-Next page;  11-Previous page;  12-Position to page; 
13-Enlarge; 14-Reduce; 15- Optimal; 16- Undo; 17-Redo; 18- Switch to ScienceWord  documents.

Let note that " Screen pencil", "  Ersaer" and "  Tool" have many important options.

The following shows Screen pencil and eraser options

Screen pencil options Eraser options

The options of eraser are available only when you have drawn or written with the screen 
pencil.This handwriting does not appear in print preview. You can remove any such handwritting 
with eraser or by clicking on "Remove handwritin from all pages".
The tool options are as shown below:  Black, White, Searchlight and Curtain. 

Tool options
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When you click on black  ( White ) option the screen becomes black ( white ) . You would click on 
the screen to get it back at the normal view. 
When you click on Curtain option, a curtain ( as shown below ) covers automatically the screen 

You can open it from the left, the right, the top or the bottom.
When youc click on the option Searchlight , you get the following that helps to save as image, any 
part of the screen with a good resolution and a small size..

Elliptical region option    Rectangular region option

You can shift it, enlarge or reduce it from the left or right corners.

Buttons to reduce or
increase the darkness

Save button

Hide toolbar button∕ Right click
mouse to display back

Close toolbar button

10 )  Customizing of slides

You can customize your normal display page or Note page from the “Master”  sub-menu of 
“View” menu.

The "Slide master" is the model of the normal display page.
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The "Handout master" is the model of the Header and footer 

The "Notes master" is the model of the notes page

Any modification on a master leads therefore to the same modification on the new slide created 
from the “Insert” menu or the “Enter” key of the keyboard.

11 )  Add a new template 
You can add a new template with sound, video, flash or geometrical construction animation. The 
steps are as follow:
Click from the View menu on Master and then on "Slide master" as the illustration shows below.

Then custom settings ( text level color,  slide background,  insert multimedia or macromedia, 
drawings and animation, etc ) . 

Then save it as for exemple "New template1. xot" as shown below.  in the Template folder of 
ScienceWord in programme files:  The path is as follows: .Disc C ⟶Programme file ⟶ 
Novoasoft ScienceWord folder ⟶ Version 6.0 folder ⟶ Template folder.
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Then close PagePlayer file and open it again, then select Slide-Template from Task Pane. At the 
bottom of list of templates, you will get the new template1.

III- Creation of a simple document 

1 )  Scientific text

We define scientific text as a combination of an ordinary text ( for a simple correspondence ) , of 

mathematical expression such as  x2, x , 1
x

, etc., mathematical symbols such as ∇, ∂, ≠ , ≌, ℤ,  ⟲,  ⊥ ,  ⋛ ,  etc,  simple chemical expressions such as NaOH + HCl   NaCl + H2O ,   

2H2O2

FeCl3 2H2O + O2↑, etc.

Processing of mathematical and chemical expressions generally appeals to mathematical models 
by clicking on  “Expression” sub-menu of the task pane.

You obtain a user friendly display of all these models as shown in the image 
at the opposite.

You can also obtain from the task pane a user friendly display of 
mathematical symbols. However we wish to recommend for convenience 
sake, to display toolbars of expressions and mathematical symbols.

To display the toolbar of expressions, right click on the "Menu Bar", then in 
the contextual menu that opens click on “Expression”. Repeat the same 
process to display the toolbar of symbols

Then toolbars appear right above the standard toolbar as below

Expression toolbar  

Symbols toolbar  
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 In the expression toolbar we can note from left to right the Brackets menu  ,  fractions and 

root , etc…

In the mathematical symbol toolbar, we note from the left to the right fundamental mathematics 

menus , small Greek characters  , etc…

When you click on a mathematical model, it appears where the cursor blinks with one or several 
dotted rectangles ( )  indicating that you are in mathematical mode; all the same when you click 
on a mathematical symbol, this symbol appears where the cursor blinks.

For example to write the fraction
3x+α
2x‒β  click on  in the "Fraction and root" menu. This model 

appears where the cursor is positioned and you need only to write “3x+α ”  to the numerator 

and “2x-β”  to the denominator.  Greek characters α and β  are inserted from greek small 

characters menu. We use the arrow keys left (← )  and right (→ )  to position the cursor on the 
numerator, denominator or outside the fraction. You can also position the cursor by clicking on the 
mouse at the desired spot.

In the case of insertion of several symbols or expressions from the same menu,  it is more 
convenient to have the menu displayed on the screen. Only click on the said menu and position the 
pointer of the mouse on the doted line which appears at the end of the menu that appears. When 

the pointer takes the shape of the cross as below , press the left button of the mouse and drag 

the menu toward the outside to a position convenient to you,  then release the left button of the 
mouse. By acting thus on the menu previously used, we get the images as below.

    

You can also make use of a shortcut key to display a mathematical model.  For example,  the 
insertion of a root square is directly obtained by holding “Ctrl” down and by pressing “R”
 key ( a type of operation noted “Ctrl + R” ) . You can access the list of shortcut keys of current 
expressions through “Insertion” menu, as they appear as below.
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2 )  Automatic formatting of mathematical expressions

The scientific text in PagePlayer can be a combination of expression in mathematical mode and in 
ordinary text.  The writing of scientific text is simplified when the ordinary text and the text in 
mathematical mode have the same automatic formatting.  This is possible when “Intelligent 
Adjust ”  tool is activated in the "Format Toolbar" .  To activate or deactivate “Intelligent 
Adjust ” tool, click on  or use “Ctrl + Shift + I” shortcut key. 

Practical application

Activate “Intelligent Adjust ” tool, then write the following expression:

f ( x ) =xcos ( x ) +2sin ( x ) − sin ( x )
cos( x )+ 2

To understand better,  please click on “Format”  menu,  then in the menu that appears,  click on 
“Expression style”. The following dialog box appears, indicating the automatic formatting for the 
writing of mathematical mode.

Text refers to the following characters: &,  ",  ',  $,  £, ù, @ ,  \ ,  
~ ,  ̂   

Symbol refers to the mathematical symbols: ≥, ≤, ≠, ≌, ≦  …

Number refers to the numbers 0, 1, 2, 3 …., 9…

Greek refers to greek letter.

Variable refers generally to letters of alphabet.

Function relates to simplified mathematical functions such as sin, 
cos, tan etc., which refer respectively to sinus, cosines, tangent, etc. functions

Operator refers to the mathematical symbols:   ±, +, ‒, ⨉, ∃, ∀ , ∈ , ∉ , ∪ , ⊘... 

Decimal point refers to the point ( . )

Punctuation refers to the characters: ,, ;, :, !, )  and ( .

3 )  Simple forms of chemical equation

Simple equation forms are those that we can express through the aid of mathematical models. 

Letters that appear in such equations are straight ( not in Italic )  for example:  2H− + 2e− = H2↑
We therefore recommend that, while typing chemical equation, the “Italic” case of the variable in 
the expression style dialog box be deactivated.

Activate thereafter “Intelligent Adjust” tool.

In the text zone “Click to add title”, click and write: Introduction to chemistry. Then, select 
the text zone “Click to add sub-title” and remove it.
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Click to add a title

Click to add a sub-title
Insert a new slide ( See lesson 2 ) . You obtain a page like the image above

1. Click to add a text
In the text zone “Click to add a title”, click and write: Simple chemical equations

Generally,  it is convenient to write the expression of a chemical reaction when “Intelligent 
Adjust”button is activated and  the “Italic”  case of variable is deactivated in the Expression 
style dialog box. 

In the text zone “Click to add a text”, click and write the following equations: 

1. C ( s ) +O2 ( g )  

 
CO2 ( g ) ; ΔH=−393.5 kJ/mol 

2. H+ ( aq ) +OH− ( aq )  

 
H2O ( l ) ; ΔH=-57kJ/mol.  

Select the first equation and add an animation effect ( for example, "Fly in" effect  see 4.a ) . This 
equation appears in grey selected as shown in the following illustration.

Apply thereafter another effect to “ΔH=-393.5kj/mol” expression.
Do the same thing for the second equation.
Animate finally your document using the Slide Show.

4 )  Major type of page designs

We have two major types of slide page design:

Customizing through a choice of the proposed slides designs.

Customizing of a blank slide obtained through removal of text zones which appear by 
default.  This choice comes very often when we want to carry out a geometrical drawing,  a 
graphical representation, macromolecular, experimental tools, etc.

Let's note that any object found in a zone demarcated by the pointer of the mouse is 
automatically selected.  The method of selecting with the pointer of the mouse is therefore very 
efficient to select several objects.
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